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Introduction

This booklet explains how to view the images you took with the
PENTAX Optio 43WR on your PC. Keep this manual in a safe place.

Regarding copyrights

Images taken using the Optio 43WR that are for anything other than personal
enjoyment cannot be used without permission according to the rights as
specified in the Copyright Act. Please take care, as there are even cases
where limitations are placed on taking pictures even for personal enjoyment
during demonstrations, industrial enterprise or as items for display. Images
taken with the purpose of obtaining copyrights also cannot be used outside
the scope of use of the copyright as laid out in the Copyright Act, and care
should be taken here also.

Regarding trademarks

The SD logo S is a trademark.

PENTAX is a trademark of PENTAX Corporation.

Optio is a trademark of PENTAX Corporation.

All other brands or product names are trademarks of registered trademarks
of their respective companies.

Apple, the Apple logo, AppleScript, the Apple Store, Mac, the Mac logo,
Mac OS, Macintosh, and QuickTime are trademarks of Apple Computer,
Inc., registered in the U.S. and other countries.

This product supports PRINT Image Matching II.

When used in combination, PRINT Image Matching Il enabled digital still
cameras, printers and software help photographers to produce images
more faithful to their intentions.

Copyright 2001 Seiko Epson Corporation. All Rights Reserved.

PRINT Image Matching is a trademark of Seiko Epson Corporation.
“PictBridge” allows the user to connect the printer and digital camera
directly, using the unified standard for the direct printout of images. You
can print images directly from the camera through a few simple operations.

» Symbols used in this manual have the following meanings:

= Gives page numbers explaining related operations.

= Gives information that is useful to know.

s | Gives cautions and notes about the operation.

The PC screenshots in this booklet may differ from your PC, depending on
your model.
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How to Use the Captured Images

Here are some ways to use the images captured with your digital camera.

Direct Print

Connect your camera and printer that

is compatible with "PictBridge" directly

with a USB cable, and print images.

« For details, see the operating
manual of the printer you are using.

Piabidge

+ using Windows 98/98 SE/Me/2000/XP as

Is your computer...
+ equipped with a standard USB interface?
your OS? Or Mac OS 9.0-9.2/10.1 or later?

Connect your camera

N and computer with a
USB cable, and copy
the camera images.

Is your computer...
* using Windows 95/NT,
Mac OS 8.6 or an earlier OS?

i — >

Transfer your images using
Use your photo shop | a built-in card slot + PC card

adapter or a card reader.

* Remove the card from the
camera. When transferring
images on the cardtoa PC
with another device, make
sure to review the user
manual accompanying
that device.

Have prints made from your
card images at a photo shop.
+ Set DPOF settings on your
camera, and get prints from
your photo shop.
1> Camera Operating
Manual (p.85)
« Select the images for prints.




I Use your image data ‘

Use your e-mail software to attach images to e-mails, or a
use them on your homepage.

» See the operating manual of your
email software for details on how to
make attachments to e-mails.

» See the operating manual of the
software you are using for details on
how to use images on your
homepage.

~

Use your printer

m—==) | (ACDSee for PENTAX = p.26-44
 View Images « Edit Images
» Save processed images ¢ E-mail Images
q » Manipulate images * Printimages Print images from your
* These operations also can be performed computer to your printer.
using commercially available image editing Some printers can print
software. See the instructions provided with directly from cards.
the software for more details. « For details, see the

operating manual of the
printer you are using.

‘ Save your image data

Images sent to the computer can be
saved onto a CD-R or other media.




Viewing Digital Camera Images on a

Windows PC

You can use the provided USB cable (I-USB7) or a card reader to
transfer your digital camera’s images to the PC, and you can edit and
print your images using the image viewing software. Here, the
method for viewing images with the provided software (S-SW18) is
explained.

Software Provided

The following software is included in the CD-ROM (S-SW18)
provided.
» Image viewing / editing software (ACDSee for PENTAX)
* QuickTime™ 6.0

System Requirements

@ USB connection
+ OS: Windows 98 / 98 SE / Me / 2000
Windows XP Home Edition / Professional
(Installation of the driver is necessary for Windows 98 / 98 SE)
» USB port must be standard equipment

® Application Software
<ACDSee for PENTAX>
(9 languages: English, German, French, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)
+ OS: Windows 98 / 98 SE / Me /
NT (latest version) / 2000
Windows XP Home Edition / Professional
+ CPU: Pentium or higher recommended
* Memory: 64MB minimum
» Hard Disk space: 40MB minimum
+ Display adapter capable of displaying a minimum of 256
colors
* Internet Explorer 4.0.2 or later




* Some formats may require viewing with QuickTime 6.0 or later and
DirectX 8.0 or later.

* To install ACDSee for PENTAX, Windows Installer Service
Version 2.0 may be required.

You can download DirectX and Windows Installer Service from
the following website.
http://www.microsoft.com/windows/directx
http://www.microsoft.com/windows2000/techinfo/
howitworks/management/installer.asp

<QuickTime>
(6 languages: English, German, French, Spanish, ltalian, Japanese)

+ OS: Windows 98 / 98 SE / Me /

NT (latest version) / 2000

Windows XP Home Edition / Professional
« CPU: Pentium or higher recommended
* Memory: 128MB minimum

* Operation is not guaranteed on all PCs meeting the system
requirements.

You may play movie pictures taken using the provided software
[ACDSee for PENTAX] (QuickTime 6.0 or later required).

W » The software cannot be used on Windows 95.
» We recommend using the AC Adapter D-AC5 (optional) when
connecting your camera to your PC. Your image data could be
corrupted if your batteries run out during image transfer.
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Installing the Software

This section describes the procedures for installing the necessary
software.

Installing the USB driver g p.6
Installing the image processing software (ACDSee for PENTAX)
= p.10

Installing the USB driver on Windows 98/98 SE only

If you are using Windows 2000, Windows Me or Windows XP, you
do not need to install the USB driver. When you connect the camera
to your computer with the USB cable, your computer will
automatically detect the camera as [Removable Disk].

1
2

Turn your computer on.

Insert the CD-ROM (S-SW18) into the CD-ROM drive.
The PENTAX Software Installer screen appears automatically, but
no action is required at this stage.

Make sure the camera is turned off and connect it to
your computer with the USB cable.

~

Turn your camera on.

Your computer will automatically detect the camera as new
hardware and the Wizard screen will appear.



Click [Next].

“This wizard searches for ew divers f:

FENTA Opto0

A d

Select [Search for the best
driver for your device] and
click [Next].

Select [CD-ROM drive] and
click [Next].

If another item has been selected,
click the box to deselect it.

Ioc
I~ Floppy disk dives

¥ CO-ROM diive

T Microscft Windows Update.

T~ Specity als

Confirm that [PENSSTOR.INF]
is displayed and click [Next].
Installation of the driver starts.

Windowe diver fle szarch forthe device:

PENTAX USB DISK Device.




10

11

12

Click [Finish].

When installation is finished,
installation of the driver for the new
hardware starts.

Click [Next].

Select [Search for the best
driver for your device] and
click [Next].

Select [CD-ROM drive] and
click [Next].

If another item has been selected,
click the box to deselect it.

This wizard searches for new divers for:

PENTAX DIGITAL_CAMERA

A device diver s a soft
hardware device k.

ware program that makes

locations: Cick Nestto stat the
T Elogpy disk divest

¥ COAOM dive.
I Bicrosoft Windows Update:

T~ Specity alocation:
D Wi AudioN 1373\ inde




13 cConfirm that [PENSPDR.INF]

is displayed and click [Next].

14 click [Finish].
When installation is finished, the
Wizard window is exited.

15 Double-click [My Computer]
on the desktop.
A removable disk will be added.

[Add New Hardware Wizard

Windaws diver fle search for the device:

PENTAX DIGITAL_CAMERA

. Cancel

T'fie £ o Faoie: Tk b

=

o0
[ =]
o

= o

= & =

GGt




Installing the image processing software
(ACDSee for PENTAX)

This section describes the procedures for installing ACDSee for
D PENTAX which lets you view and edit recorded images on your
computer.

When multiple accounts have been setup in Windows 2000 or
Windows XP, login by the authority of the administrator before
installing the software.

1 Tum your computer on.

2 Insert the CD-ROM (S-SW18) into your CD-ROM drive.

The PENTAX Software Installer screen is displayed on the
desktop.

When the PENTAX Software Installer screen is not displayed
Display the PENTAX Software Installer screen following the steps below.
1 Double-click [My Computer] on the desktop.

2 Double-click the [CD-ROM drive (S-SW18)] icon.

3 Double-click [Setup.exe].

3 Click your applicable language. sem=mz=s
y PP guag PENTAX " sorware instater

You can choose the languages from
the displayed screen.
A selection screen to install your

Francais ) MR )

desired software is displayed. Deutsch ) _#iZol )
Espaiiol ) HAE )
Italiano )
Pycckuit ’

PENTAX somar s

4 Click [ACDSee™].

English ) ACDSee™ )

QuickTime ™

Product Registration )

Back ) Exit )




The Setup screen will appear. 505 1P ot
Follow the on-screen guidance and | acoseS®s, A
enter the registration information. p j fita
Reboot your PC after installation £ Q

N

finish. mg
oo it

o the
0 Power Pa

* If QuickTime 6.0 or later is not
a|ready insta”ed in yOUr PC’ a & ACDSee for PENTAX requires Quick Time B.0 or greater

to views videos made with your PENTAX camera,

message SUCh as the one Shown s recommended that you install QuickTime before

installing ACDS e for PENTAX,

on the right is displayed before =
the Setup screen appears. Click —
[Install QuickTime] to first install ==
QuickTime 6.0.

The panoramic image software “Photostitcher”, the image layout
and printing software “FotoSlate”, and the image editing software
“FotoCanvas” are also installed when you install ACDSee for
PENTAX.




Product Registration on the Internet

Please click the [Product Registration] of

the CD-ROM screen in step 4 on the
D page 10 of this PC manual.

A world map of the Internet Product

Registration is displayed.

If your PC is connected to the Internet,
click the displayed country or region and
then follow the instructions to register
your product.

Thank you very much for your cooperation.

Lmemo Only the customers of displayed countries and region can register
their products on the Internet Product Registration.




Copying Images to your PC

An explanation of how to copy images using ACDSee for PENTAX
is shown below.

Refer to the “About ACDSee for PENTAX” (1= p.26) to view or edit (,
the copied images.

Setting the USB Connection mode to [PC]

Quick Zoom off

1  Press the MENU button in Playback mode.

2 Press the four-way controller (») to display [{i Set-up]
menu.

3 Usethe four-way controller (A V) B i
to select [USB Connection]. USB Connection <PC

4  Use the four-way controller (€») || yeetsetng
to select [PC] . Quick Delete On

5

Press the OK button.

@EDEXte) 0K




Copying Images to your PC

1
ok

Turn your computer on.
Turn your camera off and connect it to the PC with the
USB cable.

Confirm that the SD Memory Card is inserted in the camera when
the images in the SD Memory Card are copied.

/

Turn your camera on.
The Device Detector screen is displayed automatically.

If the Device Detector screen is not displayed, display / copy the
images following the steps in “When the Device Detector screen is
not displayed.” on page 16.
Confirm that [Copy images to m=
hard drive] and [Launch i

ACDSee] are checked, and
(o] I i ck [N ext] . W LonchACDSee

<Back [ Cancel




Click [Browsel].

The [Browse For Folder] screen is
displayed.

I Delte images from memory card aiter copying them

Select a destination folder and 20z

Cl Ick [O K] . Select 2 destination folder

Desktop
B4 My Documents
- B adobe
0 My eBooks
- (2 My Pictures

Click [Next].

Create a new subfolder named:
[2m0401-16

Tip Name the new sublolder something which descbes this group ofmages.
[V Bename files using this name

The image is copied to the PC, and
the ACDSee for PENTAX Browser

starts.
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When the Device Detector screen is not displayed.

4

5

Double-click the [ACDSee for M
PENTAX] icon on the desktop.

ACDZee for
PEMNTAX

Double-click [My Computer].

Double-click [Removable Disk] =
(If the SD Memory Card has a
volume label name, then select |:
that name).

Double-click the [DCIM] folder. T

Click the [xxxPENTX] folder.
(xxx is a 3-digit number.)




9 select [Copy To...] from the
[Edit] menu.
The Copy Files screen is displayed.

10 click [More>>] and select the 20
destination folder. .

11 Click [OK].
The image is copied to the PC.




Disconnecting the Camera from your PC

Windows 2000 / Me

_ 0N

"memo

Double-click the [Unplug or
eject hardware] icon in the task
bar recognized area.

The [Remove Hardware] screen will
appear.

Confirm that [PENTAX USB = b o e o
DISK Device] is selected and
click [Stop]-

The [Stop Hardware Device] screen
will appear.

Unplug or eject hardware  Eict Hardware

PENTAX LIS DISK Device at PENTAX Optio30

I Display device componerts

¥ Show Unplug/Eject jcon on the taskbar Close

Confirm that [PENTAX USB 2 o e device 21
DISK Device] is selected and o= = omt oo

click [OK].

A message will appear. SRR A

Windows will attempt to stop the following devices. After the devices are
stopped they m afely.

Click [OK].

Turn off the camera and
disconnect the USB cable from your camera and PC.

The computer is downloading the camera’s image data with the camera is
connected to the computer and the camera viewfinder lamp (red) is
blinking. Image data may be damaged if you disconnect the camera during
such conditions.

In the event that an error message is displayed in Step 4, confirm that
the viewfinder lamp is not blinking and then disconnect the camera.



Windows XP

1 Double-click the [Safely
Remove Hardware] icon in the EETTITET |
task bar recognized area.

2 Click [PENTAX USB DISK £ Safely Remove Hardware (@]
Device] and click [Stop]_ % Seletuhedev\ceyuuwamIaunv\ugﬂve\e?’,‘jzgAhenchckSmp when

computer,

FENTAX USB DISK Device at PENTAX 0ptio30

Propetties Stop.
[ Display devics components
3 Click [PENTAX USB DISK el s %
D ev i ce] an d cl i c k [o K] Confim devices to be stopped. Chaose OK ta cortinue,
windows il atempt o stop the folowing devicss. Afer the devicss are

stopped they may be removed safely.

e PENTAX DIGITAL_CAMERA ISB Device

Co

4 Whena message is displayed
permitting removal, turn the
camera off and disconnect the
USB cable from your camera
and PC.

Windows 98 / 98 SE

There is no hot plug icon in Windows 98 / 98 SE. Confirm that the
viewfinder lamp (red) is not blinking before disconnecting the
camera, simply turn off the camera and disconnect the USB cable.




Viewing Digital Camera Images on a

Macintosh

You can use the provided USB cable (I-USB7) or a card reader to

transfer your digital camera’s images to the Mac, and you can edit
and print your images using the image viewing software. Here, the
method for viewing images with the provided software (S-SW18) is
explained.

D Software Provided

The following software is included in the CD-ROM (S-SW18) provided.
» Image viewing / editing software (ACDSee for PENTAX)
* Panoramic image software (ACD Photostitcher)

System Requirements

o USB connection
« OS: Mac OS 9.0-9.2/10.1 or higher
» USB port must be standard equipment

* Installation of the driver is not necessary.

® Application Software
<ACDSee for PENTAX and ACD Photostitcher>
(6 languages: English, German, French, Spanish, Italian, Japanese)
* OS: Mac OS 8.6 or higher
(requires QuickTime 4.0 or higher and the
latest version of CarbonLib)
« CPU: Power Macintosh 266MHz or higher
* Memory: 8MB minimum
* Hard Disk space: 6MB minimum
* The classic system is necessary when using ACD Photostitcher
with Mac OS X or higher.
* Operation is not guaranteed on all PCs meeting the system
requirements.

m We recommend using the AC Adapter D-AC5 (optional) when
connecting your camera to your PC. Your image data could be
corrupted if your batteries run out during image transfer.



Installing ACDSee for PENTAX

This section describes the procedures for installing ACDSee for
PENTAX which lets you view and edit recorded images on your
computer.

Turn your Macintosh on.

Insert the CD-ROM (S-SW18) in the CD-ROM drive.
Double-click the CD-ROM (S-SW18) icon.

Double-click the [Install ACDSee™] icon. ®
The PENTAX Software Installer screen is displayed on the desktop.
Double-click the [Master Installer] icon to display [PENTAX

Software Installer] screen.

5 cClick your applicable
language.

You can choose the languages from
the displayed screen.

A selection screen to install your
desired software is displayed.

AWON -

PENTAX " sottware tater

——

Francais )
Deutsch )
Espaiiol )
Italiano )
BAE )

6 Click your applicable Mac OS.

The software selection screen will
appear.

7 Click [ACDSee™].

The setup screen will appear.
Follow the on-screen guidance to
input registration information and o050 ) oS
install the software.

English )| _Acpsee™ )

Product Registration >)

Back )  Exit )




%

T If the message [CarbonLib-xxxxx could not be found] is displayed

during installation, you must add the function expansion file called
“CarbonLib” to the function expansion folder in the system folder in
order to install the provided software in Mac OS 8.6 - 9.2.
This error message is appeared when this function expansion file is
not present or when an old version of the file is present.
The latest version of the Carbon Lib is available on the Apple
website. Download the file and then install it onto Mac OS.
Apple website: http://www.Apple.com

D Contact Apple for detailed information on how to use Carbon Lib.

Installing ACD Photostitcher

This section describes the procedures for installing ACD
Photostitcher which lets you join a number of images together to
form a panorama picture.

1 Double-click [ACD

Photostitcher].

The licensing agreement will appear ng.i.. ). _AcDSee™ )

on the screen. When you have read macoss )| Acopnotosticher )

it, click [Agree] to accept the terms of

the agreement. Product Registration __©>)

Back ) Exit )

2 Choose a destination for the |

software and click [Install].

Installation starts. When the

message appears telling you that

the software has been successfully S o]

installed, click [Quit]. s ) |




Product Registration on the Internet

Please click the [Product Registration] of —
the CD-ROM screen in step 7 on the
page 21 of this PC manual.

A world map of the Internet Product
Registration is displayed.

If your PC is connected to the Internet,
click the displayed country or region and then follow the instructions (,
to register your product.

Thank you very much for your cooperation.

%

— Only the customers of displayed countries and region can register

their products on the Internet Product Registration.

Displaying Images on your Macintosh

Setting the USB Connection mode to [PC]

1  Press the MENU button in Playback mode.

2 Press the four-way controller (») to display [t Set-up]
menu.

3 Usethe four-way contrc?ller (AV) T -
to select [USB Connection]. [USB Connection <PC

4  Use the four-way controller (€») || jieetsetne
to select [PC] . Qu?ck Delete On

Quick Zoom off
5 Press the OK button. EDET®OK




Displaying images on your Macintosh

1
2

Turn your Macintosh on.
Turn your camera off and connect it to the Macintosh
with the USB cable.

Confirm that the SD Memory Card is inserted in the camera when
the images in the SD Memory Card are copied/displayed.

Turn your camera on.

The camera is recognized as [untitled] ((NO_NAME] in
OS X) on the desktop. The folder name can be B
changed.

Double-click the [ACDSee™] folder on the desktop.
Double-click the [ACDSee™] program icon.

An image list (Browser) is displayed.

Open the camera folder.

The camera images are in the [untitled] (or volume label name if
the SD Memory Card has one) — [DCIM] — [XXXPENTX] (XXX is
a three-digit number) folder.

An image list of the camera is displayed.

untitled



7  Select the image to view from the image list.
Double-click the image you selected. A full-size image is displayed
(Viewer).

1 If the SD Memory Card has a volume label, the volume label name
will be displayed instead of “untitled”. A new SD Memory Card
unformatted may show the manufacturer name or model number.

Copying images to your Macintosh

See your Macintosh user’s manual for how to copy or move files. (]
Please copy images to your Macintosh before editing them.

Disconnecting your Camera from your Macintosh

1 Drag [untitled] (or the volume label name on the SD
Memory Card) to your trash.

2 Disconnect the USB cable from your camera and your
Macintosh.
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About ACDSee for PENTAX

“ACDSee for PENTAX” is a comprehensive software package that acquires,
organizes, displays, processes, and shares digital camera images.

You can use the Browser (1= p.27) to acquire digital camera images
efficiently. You then can organize them in your favorite way and even
display them as thumbnails.

You can use the Viewer (1 p.34) to view a large version of a single image.

Further, when you install “ACDSee for PENTAX” which is on the
provided CD-ROM (S-SW18) on a Windows PC, the panoramic
image software “Photostitcher”, the image layout software
“FotoSlate”, and the image editing software “FotoCanvas” are also
installed at the same time.

Use this software to enjoy an even higher degree of freedom in your
image creation, editing and processing.

This manual provides explanations regarding the most basic
“ACDSee for PENTAX” functions. Refer to the Help section in
“ACDSee for PENTAX” for detailed information.

Launching ACDSee for PENTAX

For Windows

1 Double-click the [ACDSee for PENTAX] icon on the
desktop.
ACDSee for PENTAX will launch and an image list (Browser) will
be displayed.

For Macintosh

Double-click the [ACDSee for PENTAX] folder on the
desktop.

2 Double-click the [ACDSee for PENTAX] program icon.
ACDSee for PENTAX will launch and an image list (Browser) will
be displayed.

To exit ACDSee for PENTAX

Select [Exit] from the [File] menu in the Browser or the Viewer.



Viewing using the Browser

In “ACDSee for PENTAX”, you can view images using either the
Browser, which displays a list of images, or the Viewer, which display
one image at a time.

The Browser is displayed when you launch “ACDSee for PENTAX.”

About the Browser

Here, explanations are provided regarding Browser configuration as
well as names and functions within the Browser.

For Windows

D ACDSee for PENTAX - 100PENTX. -8 x|

HE H & % % @8

Resize Rename Dsich Ferame Rotate Exposure SideShow | Back Forwerc

Ele Edit ¥ew Incls activiiss Help

e s W m.

__Print Share Edtor  Creste Fhofostiche Walpaper

84 search | (5 calendar Categories i az. -l e | B il
B Foders &) Phota Discs MewFolder | Fiter  Sort  Mode | Audio Properties | Moveto Copyto |
(Cew Folder () Add to Favorites ['23 cpocuments and settingsiAdniristratoritly Documentsiy Picturesi100PENTY |
Desktap e C =
=143 My Documents i
EE My Pictures : - % y
@ — | 23 1D0PENTX =
Iy Computer o
v Network Places 1600x1200x24b | 1600x1200:24b | BY 4h 1600x1200x24b
IMGPO00L. jpg Jpa

Total 4 fles (752,00KE) [154.6KB, 7/9/2003 3:07 FM [T IMGFO0D3.jpg [1600x1200:24b jpeg | | —

@ Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu
bar.




@ Browser toolbar

Browser toolbar includes shortcut buttons for commonly used
functions and tools. These buttons open dialog boxes or display
further activity buttons.

You can customize the toolbar by turning the button labels on or off,
adding or removing buttons, and changing the size of the buttons.

® Navigation pane

Navigation pane displays a folder tree of the folders on your
computer, extra drive, or peripheral device.

Navigation pane includes the Folders, Calendar, Categories, Photo
Discs, and Albums tabs. You can select these tabs to display their
contents in the File pane, or to organize your files and folders.

@ Preview pane
Preview pane displays the image selected in the File pane.

®File list toolbar

With these shortcut buttons, you can copy, move or delete items,
select what file types or folders to display in the File pane, and sort
your images. You can customize the toolbar by turning the button
labels on or off, adding or removing buttons, and changing the size
of the buttons.

® Path box
Path box describes the location of the folder of images currently
displayed in the File pane.

@File pane

File pane displays the contents of a folder selected in the Navigation
pane as a list of files or as thumbnails.

You can sort your images by such criteria as file name, file extension,
file size, file date, etc.

Status bar

Status bar displays information and properties for the selected
folder, file or files.

¥

o When these categories are not displayed, check ([+ ) the categories

you want to display in the [View] menu.



For Macintosh

®—'a File Edit View Image Media_Tools Windows Help

|=)
@ el isnlpl=fefE s [e) = =]
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@ Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu
bar.

@ Browser toolbar

Browser toolbar includes shortcut buttons for commonly used
functions and tools. These buttons open dialog boxes or display
further activity buttons.

@ Navigation pane
Navigation pane displays a folder tree of the folders on your
computer, extra drive, or peripheral device.

@ Preview pane
Preview pane displays the image selected in the File pane.




®File pane

File pane displays the contents of a folder selected in the Navigation
pane as a list of files or as thumbnails.

You can sort your images by such criteria as file name, file size, file
date, etc.

Changing the Browser display method

You can select any of the following 6 methods to display lists of
images in the Browser.

Select [Mode] in the [View] menu and then select a display method
from the submenu. You can choose from the following display
methods.

Thumb+Details
Display image file thumbnails and file information in a list format.
You can change the file information that is displayed. (1= p.33)

Thumbnails
Display image file thumbnails.

Large Icons
Display large icons and file names.

Small Icons
Display small icons and file names.

List
Display small icons and file names in a list format.

Details
Display small icons and file information in a list format.
You can change file information that is displayed. (1= p.33)



Viewing images in other folders

To view images stored in other folders, select a folder from the folder
tree in the Browser Navigation pane or directly specify a folder in the
path box.

Selecting a different folder in the folder tree

Folders selected from the folder tree are designated as the current
folder and images from that folder are displayed in the File pane.

To display a subfolder

is displayed next to the folder icon of folders that contain
subfolders. Click [+] to display the subfolders. [-] is displayed next to
folders when subfolders are displayed. Click [=] to hide the subfolders.

Use the buttons on the Browser toolbar to select a
different folder.

You can view the contents of the folder one level above the current
folder by clicking (&= in the Browser toolbar.

You can view the contents of the folder displayed prior to the current
folder by clicking (& in the Browser toolbar.

When you use [& in the Browser toolbar to change the displayed
folder, click (2 to return to the folder displayed after the current folder.

Specifying a different folder using the Path box

Select [Path Box] from the [View] menu to display the path box in the
File pane. Directly enter in the path box the path of the folder
containing images you want to view. Images in that folder are
displayed in the File pane.

Also, click = to the right of the path box to display a dropdown list
containing a history of recently used folders. Select from the list a
folder with images you want to view. Images from that folder are
displayed in the File pane.

o



Sorting image files

You can change the order of image files displayed in the File pane.

Selecting sort categories

Select [Sort] from the [View] menu and then select a sort key
category from the submenu.

You can choose from the following categories.

Extension, Name, Size, Type, Date, Image Properties, Description

Specifying ascending / descending order

Select [Sort] from the [View] menu and then select [Forward] or
[Reverse] from the submenu.

%

o~ Clicking the right mouse button on the File pane background

(empty area where images are not displayed as thumbnails or
icons) will display the menu in the location of the cursor. You can
use the same step to rearrange the menus.

* For Macintosh, you can choose from the following categories: File
Name, File Size, Image Type, Date and Reverse Sort Order.

Sorting using the keyboard

You also can sort image files and specify ascending / descending
order using the numeric keypad on the keyboard.

0:Extension 4:Date

1:Name 5:lmage Properties

2:Size 6:Description

3:Type +:Forward
-:Reverse

Enable NumLock by pressing the NumLock key on the keyboard
when you want to sort using the numeric keypad.



Setting detailed display categories

You can specify items displayed in the list as well as change the
category order when the File pane is set to Details display.

Settings display categories

Select [Columns] from the [View] menu and then select a display
category from the submenu.

You can choose from the following categories.

Size, Type, Date, Image Properties, Description

Select another categories to remove checks when you do not want
to display details.

%

— Clicking the right mouse button on the file list row header (portion

where name, size, and other categories are written) will display the
menu. You can use the same step to set the display categories.

o

Adjusting the width of display category rows

You can adjust row width to match the amount of text displayed in
the list. Align the cursor with the edge of the row header. Click on the
edge when the cursor changes to a left-right arrow head and drag the
edge to adjust the row width.

¥

o Double-clicking the left mouse button on the row header separator

will automatically adjust the row width to match the length of the list
text.




Viewing a Large Version of an Image

(Viewer)

Double-click on a single image file selected in the Browser to display
a full-screen view of that image.

About the Viewer

Here, explanations are provided regarding Viewer configuration as
well as names and functions within the Viewer.
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® Menu bar

You can select and execute the various functions and settings of the
ACDSee for PENTAX by choosing the menu items from the menu bar.




@ Viewer toolbar

Viewer toolbar includes shortcut buttons for commonly used
functions and tools such as the Zoom tools.

You can customize the toolbar by turning the button labels on or off,
adding or removing buttons, and changing the size of the buttons.

@ Viewer pane
Viewer pane displays your images one at a time in full resolution.

@ Sstatus bar
Status bar displays information and properties for the selected
folder, file or files.

%

o When the viewer is displayed, you can close the viewer and switch

to the browser by performing any of the following.
+ Click the x| (close) button.

» Double-click on the viewer pane border.

* Press the [Esc] key on the keyboard.




Panorama Image Stitching with ACD

Photostitcher

With ACD photostitcher installed on a Windows PC, you can
panorama stitch the images you took in Panorama Assist mode.
The folder and image names displayed on the explanatory
screenshots will differ according to the setup of your PC.

W * When multiple accounts have been setup in Windows 2000 or
Windows XP, login by the authority of the administrator before
using ACD Photostitcher.
+ Install ACD Photostitcher and ACDSee for PENTAX separately
when using a Macintosh.
» Panorama stitching cannot be performed on images of varying
save sizes.

Panorama Image Stitching on a Windows PC

1 Run ACDSee for PENTAX.
An image list is displayed.

2 Select the images for panorama stitching from the
image list.
Press the [Ctrl] key on the keyboard while clicking on pictures to
select multiple images.
After selecting the images, select [Extras] from the [Activities]

menu, and select [Photostitcher] from the submenu.
The [Photostitcher] is not enabled if two or more images are not

D selected.

Select images




3 Correct the image positioning.
ACD photostitcher starts, and the selected images are displayed in
panorama format.
Move the mouse pointer onto the image. It changes into a " symbol.
Hold down the left mouse button and drag the images to adjust the
stitching position.
When the position is adjusted, click the [STITCH] button.

2 Click the

[STITCH] button.

1 Click and drag to
adjust position.

)
images ]

3images, 1212 by 840

4  select the stitching method.

You can choose the stitching method from [Big Plane] and [Cylinder].
Here, you will create a flat panorama. Click the [Big Plane] button.
A confirmation message is displayed. Click [OK].

e x
ca

Click [Big Plane].

Focal Length [35 | mm

I~ 360 degree

Image Size lending
& Small & Gradual
© Medium C Steep
© Large © None

Background Color [~ Jwhite~] _Cancel

el * Click [OK] and continue if a screen like
@ P e SR the one shown left is displayed.




Trim the image.

Move the mouse pointer onto animage. It changes into a $ symbol.
Hold down the left mouse button and drag the dotted lines to adjust
the image trimming position.

When the position is adjusted, click the [Trimming] button.

4 ACD photostitche

2 Click the [Trimming]
button.

1 Trim the image.

Save the image.

After confirming your trimming, click the [Save] button to save the
image. To cancel the trimming, click the [Cancel Trimming] button.
When you are done, close ACD photostitcher and ACDSee for
PENTAX.

4 ACD photostit cher - Panoramic Image Viewer - 789 % 208

—_ -loix|
(22 )18 Click the [Save] button.

[Cancel Trimming] button




Panorama Image Stitching on a Macintosh

1 Run ACD Photostitcher.

2  Click the [Load] button.
The folder selection screen is displayed.

3  Select the folder for panorama stitching, and then click
the [Choose] button.
The image files in the selected folder are displayed.

4 select all the images for panorama stitching and then
click the arrow on the right.

The selected images are displayed on the image layout palette in
the alignment window.

Stitching method
button

5 Setting the stitching parameters.
Click the Stitching method button to open the stitching parameter C-
selection window.
You can choose the stitching method from [Big Plane] and
[Cylinder].
Here, you will create a flat panorama. Choose the [Big Plane]
button and click [OK].
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Check settings (7]

Select the panorama mode

o P !

Big Plane Cylinder

I current position  Focal length fm
stitching
[ 360 degres psnorama

Select the image size
®small O Medium O Large

Select the blending
@® Gradual QSteep (3 None

Select the background color
[Jwhite +

jinfo. ||« Click [OK]and continue if a screen like
@ Mo feature matching was Found the one shown left is dlsplayed

6 Click the [Automatic alignment] button.
The selected images are displayed in panorama format.

7 Correct the image positioning.
Click the image you want to move and display it in a red frame.
Hold down the mouse button and drag the image to adjust the
stitching position.
For easier adjustment of two images that are next to each other,
click the [Align 2 images] tab to enlarge the section where the

-) images overlap.
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Click the [Stitch] button.
Stitching starts. When finished, the stitched picture is displayed.

Trim the image.

Click the [Trim] button to display the dotted lines around the image.
Move the mouse pointer onto the dotted lines. It changes intoa t
symbol. Hold down the mouse button and drag the dotted lines to
adjust the image trimming position.

When the position is adjusted, click the [Trim] button again.

To cancel the trimming, click the [Undo] button.

After confirming your trimming, click [OK].

[0 =——————stitching result 781 x 212 (746 x 184)

| 1 Click the [Trim] button.
3 Click the [Trim] button.

—— 4 Click the [OK] button.

™ 2 Trim the image.

SEDT

2oom ratio: [ Display whole image | £ | KD
Save the image.

Click the [Save] button to save the image.
When you are done, close ACD photostitcher.
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Printing an Image

You can print image files from the Browser or the Viewer.

Printing from the Browser

You can print one or more images from the Browser.

1 Select one or more images.

To print several images, press the [Ctrl] key on the keyboard while
clicking on pictures to select multiple images for printing.

2 Sselect [Print Images] from the [File] menu.
The Print dialog box is displayed.

3 Selector change the printing options.

4  Click [Print].

Printing from the Viewer

You can print the currently viewed image, or all images that reside in
the same folder as the currently viewed image.

1 Sselect [Print Image] from the [File] menu to print the
currently viewed image.

or

Select [Print All Images] to print all images in the same
folder.

The Print dialog box is displayed.

Select or change the printing options.

Click [Print].

WN



To insert the date and print and image

You caninsert the date into an image file
and print it. Date insertion settings are
done in the Print dialog box.

1 Select the [Caption] tab in the
Print dialog box.

2 Checkthe [Printimage capture
date in the corner of images]
check box.

Creating and Printing contact sheets

You can create and print contact sheets of yourimages. You can add
captions to each image, page headers and footers, and control
thumbnails size.

1 Inthe Browser, select a group of images.

Press the [Ctrl] key on the keyboard while clicking on pictures to
select multiple images for printing.

2 select [Print Contact Sheet] from the [File] menu.
The Print Contact Sheet dialog box is displayed.

3 selector change the printing options.
4  cClick [OK].

For more information about creating and printing contact sheets,
click the Help button in the Print Contact Sheet dialog box.

o



E-mailing your Images from ACDSee for

PENTAX

You can send images directly from the ACDSee for PENTAX without
using an external e-mail application. (E-mail account setup is
required. See the ACDSee for PENTAX Help section for details.)
Image files are converted to JPEG format then attached to an e-mail
and sent. Images are compressed before transmission when the file
size is large but no changes are made to the original image.

E-mail function of ACDSee for PENTAX is not compatible with
Macintosh.

1 In the Browser, select an T 1
image or a group of images.
To select several images, press the
[Ctrl] key on the keyboard while
clicking on pictures to select multiple
images.

2 Sselect [Share] from the

Els

[Activities] menu, then select

[E-mail].

The Send E-mail dialog box is displayed.
3 Input the required information.

4 Click [Send].

For more information about e-mailing your images, click the Help
button in the Send E-mail dialog box.

T An error message may be displayed and you may not be able to
=" send mail if your mail server security is set to a high level.

_ @)



About ACDInTouch

ACDInTouch uses the Internet to display the latest information about
ACDSee for PENTAX. You can access information related to special
offers, free digital imaging resources, newsletters, subscriptions and
more.

To connect to ACDInTouch

1 Sselect [ACDInTouch] from the [Help] menu.
The Connect to ACDInTouch dialog box is displayed.
2 Click [Connect Now].

About the ACDInTouch services

ACDInTouch is a data exchange service. When you connect,
information is sent to you so that you can read up-to-date information
directly in the ACDInTouch pane. This information is relevant to your
product, such as upgrades, add-ons and related software from ACD
Systems that may also be of interest to you.

For information on ACD Systems’ Privacy Policy, visit Web site at:

http://www.ACDSY STEMS.com/english/company/privacy.htm
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